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Introduction

Welcome
Hello and welcome to the POWER LEADER Power Management Control System
for CIMPLICITY® HMI. You are about to begin using your computer in an exciting
new way—as a tool to help you increase productivity while reducing downtime and
energy costs.

This book is for anyone getting started with CIMPLICITY PMCS. It contains the
information you need to install and begin using PMCS effectively.

•  Chapter 2, Getting Started, explains the terminology of power-
management systems, describes each of your PMCS items, outlines the
minimum system requirements, and lists methods of getting GE
Technical Support.

•  Chapter 3, Installing the Software, explains how to prepare your system
and install all of the PMCS software. Any special installation steps are
outlined for each software module.

•  Chapter 4, Configuring the Software, describes how to efficiently
configure PMCS to get up and running in the shortest time.

•  Chapter 5, EPM Device Special Considerations, details the additional
configuration required to use EPM 7700, EPM 7600 and EPM 7500
meters in a PMCS network.

How to Use this Book
You will find this book easy to use if you look for these simple conventions:

•  Boldface type indicates the name of an item you need to select.

•  Monospace type indicates an example or text that is displayed on the
screen.

•  UPPERCASE type indicates a file name, command name, or acronym.
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About CIMPLICITY PMCS Version 6.9
CIMPLICITY PMCS Version 6.9 is the latest Power Management Control System in
the robust line of POWER LEADER power-management products from GE
Industrial Systems. CIMPLICITY PMCS seamlessly integrates the comprehensive
line of POWER LEADER devices, as well as many new Modbus RTU devices and
systems. PMCS comes with built-in Ethernet compatibility and is optimized for the
Windows NT 4.0 operating system. All of this adds up to the most flexible, high-
performance, open-architecture power-management system available. PMCS
software is the backbone of your new power management system, with state-of-the-
art graphics and features designed to maximize productivity and minimize downtime
and energy costs.

Performance
With built-in Modbus RTU and Ethernet compatibility, PMCS delivers critical
power-management information faster than ever. PMCS supports baud rates of up to
38.4 kbps on a Modbus RTU network and 10 Mbps on an Ethernet TCP/IP network.
This results in near “real-time” screen refresh rates and immediate access to critical
event and alarm data.

Features
PMCS comes with the following features that make the system more powerful and
easy to use:

•  Compatible with industry-standard third-party SCADA platforms.

•  Built-in Modbus RTU network compatibility for an open network
architecture and high-speed communications.

•  Built-in Ethernet TCP/IP network compatibility for very high-speed
communications and reduced wiring costs.

•  Built-in support for the comprehensive line of POWER LEADER
power-management devices, as well as additional GE meters and relays,
Fanuc 90/30 and 90/70 programmable logic controllers, plus support
for third-party meters and relays.

•  3D virtual-device interaction with accurately reproduced device look
and feel.

•  Improved waveform capture, including extensive analysis tools.

•  Comprehensive alarm and event reporting for immediate diagnosis of
electrical system problems.

•  Multiple Viewer Workstation support for seamless access and sharing
of power-management data across your existing LAN.

•  Configurable password protection and user-activity logging for
improved security and restriction of setup or control operations.

PMCS option modules are available to further increase productivity and reduce
energy costs. Your system may include one or more of the following modules:
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•  CIMPLICITY PMCS Interface Toolkit with tools to quickly create
accurate, intelligent floorplans, one-line diagrams, and elevation views.

•  System Test Simulator to design and test PMCS systems without
connection to real networks or devices.
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Supported Devices
CIMPLICITY PMCS 6.9 supports the following devices. Firmware revisions other
than those listed may not be compatible with PMCS. Contact your GE Sales
Representative or the GE Resolution Center, at 1-888-GE-RESOLV for more
information.

Device Firmware Revision Supported
POWER LEADER EPM (commnet communications option)

(Modbus communications option)
1.06
3.4

POWER LEADER Meter 2.00
EPM 3710 Electronic Power Meter 3.0.1.1.b
EPM 3720 Electronic Power Meter 1.5.1.0
Power Quality Meter (PQM) 3.2
POWER LEADER MDP Overcurrent Relay

(commnet communications option)
(Modbus communications option)

1.0
3.4

Spectra MicroVersaTrip™ 5.16
Enhanced MicroVersaTrip™ C 4.13
Enhanced MicroVersaTrip™ D 4.13
Spectra ECM™ Electronic Control Module 7.2
239 Motor Protection Relay 2.4
269 Plus Motor Management Relay D.6.0.4
369 Motor Management Relay 1.45
SR469 Motor Management Relay 30D261A8.000
SR489 Generator Management Relay 1.41
565 Feeder Management Relay VE2.71
735 Feeder Relay 25D152D1.000
SR745 Transformer Management Relay 2.50
SR750 Feeder Management Relay 4.0
SR760 Feeder Management Relay 3.60
POWER LEADER Modbus Concentrator Main Firmware 2.2

Segment Firmware 2.12
POWER LEADER Modbus Monitor 2.0
GE Fanuc MicroPLC Programmable Logic Controller n/a
ALPS Advanced Line Protection System V0004.00AA15
LPS Line Protection System V0004.00AA15
DFP100 Digital Feeder Relay 4.4
DFP200 Digital Feeder Relay 2.01
EPM 7300 Meter 1.33
EPM7500 Meter 2.05
EPM7600 Meter 2.01
EPM7700 Meter 2.0
Schweitzer Engineering Laboratories SEL-251 Distribution Relay R406
Schweitzer Engineering Laboratories SEL-321 Phase and Ground Distance Relay,
Directional Overcurrent Relay and Fault Locator

R500

Schweitzer Engineering Laboratories SEL-351 Directional Overcurrent Relay,
Reclosing Relay and Fault Locator

R103

Schweitzer Engineering Laboratories SEL-587 Current Differential Relay R503
System Monitor SM-3 Voltage Regulator 0309B
Universal Relay 2.42
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Device Firmware Revision Supported
Motor Manager II 4.02
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Getting Started

First Steps
If you are already familiar with PMCS, simply review the system requirements and
skip ahead to Chapter 3.

Getting started with PMCS is easy. This chapter explains power management and
leads you through the steps to take prior to installing your PMCS software. If you
need help with your PMCS system, the GE Technical Support telephone number is
given at the end of this chapter.

Understanding Terminology
Power-management system terminology can be intimidating to new PMCS users. The
list below defines many of the important terms and acronyms used in this guide and
other PMCS manuals. Refer back to this list as new terms are presented later.

Baud rate: A measurement of a communication channel's signaling rate or
information-carrying capacity. Communicating devices typically have configurable
baud rates to provide compatibility with various speed communication networks.
Higher baud rates generally provide faster data-refresh times.

CIMPLICITY HMI: An industry-standard SCADA software package providing
flexible, accurate, and easy-to-use graphics. CIMPLICITY HMI is based on a client-
server architecture, consisting of Servers and Viewer Workstations. Servers are
responsible for the collection and distribution of data. Viewer Workstations connect
into Servers and have full access to the collected data for viewing and control
actions. Servers and Viewer Workstations can be easily networked together to
seamlessly share data without the need to replicate your point database from node to
node.

CIMPLICITY HMI Server Development: CIMPLICITY HMI Server Development
allows you to create new projects and can also function as a runtime system.

CIMPLICITY HMI Server Runtime: CIMPLICITY HMI Server Runtime systems do
not support project configuration. They may be used as runtime systems only.

CIMPLICITY HMI Viewer Runtime: CIMPLICITY HMI Viewer Runtime connects
to Servers for viewing data and controlling actions.

Commnet: A GE Industrial Systems standard for device communications that
specifies the communication protocol and the communication network.

Communication network: A physical standard for wiring and interconnection of
communicating devices. A communication network standard usually includes
specifications of voltages, maximum cable-run lengths, shielding, termination, and



CIMPLICITY PMCS Read-This-Book-First Getting Started  ••••   9

cable requirements. RS485 and Ethernet are examples of communication-network
standards.

Communication protocol: A language or convention used for reliable transmission
and reception of binary data. A communication protocol is often independent of the
physical method or network used for transmission. Modbus RTU and TCP/IP are
examples of communication protocol standards.

DDE Server: A software application that typically runs in the background, gathering
information from the network and providing the information in DDE format for use
by one or more applications. The PMCS DDE Server is included in the PMCS
Network & Device Configurator and comes in versions optimized for Ethernet
TCP/IP or RS485 Modbus RTU networks.

DDE: Dynamic Data Exchange. A Microsoft Windows standard for efficient sharing
of data between applications on the same PC. See also NetDDE.

Ethernet Gateway: A POWER LEADER device used to connect four RS485 Modbus
RTU networks to an Ethernet TCP/IP network. The Gateway increases performance
of a PMCS system through multiple Modbus networks and reduces overall wiring
costs through reuse of existing Ethernet LAN wiring.

Ethernet: An industry-standard communication network commonly used for local-
area networks (LANs) of PCs. Ethernet PMCS systems provide very high-speed,
reliable communications at 10 megabits per second.

Event Logger: A standard PMCS application that efficiently analyzes, sorts, and logs
unusual system behavior such as circuit breaker trips, undervoltages, and
overcurrents. Extensive data-logging capabilities make it a useful tool for analyzing
and predicting system maintenance patterns.

Host PC: The PC running the PMCS DDE Server is referred to as the Host PC. All
other PCs running PMCS client programs are referred to as Viewer Workstations or
networked PCs.

Interface Toolkit: An optional PMCS tool used to quickly generate accurate and
friendly graphical user interfaces. The Interface Toolkit provides dozens of wizards
to efficiently create intelligent one-line diagrams, equipment elevation views, floor
plans, 3D virtual-faceplate views, and tabular displays.

Modbus Concentrator: A POWER LEADER device used to connect eight commnet
networks to an RS485 Modbus RTU network. The Concentrator provides full
compatibility between the PMCS software and the extensive line of POWER
LEADER devices with commnet communications, as well as simple expansion of a
RS485 Modbus RTU network to up to 247 devices.

Modbus RTU: An industry-standard, nonproprietary communications protocol
typically used in medium-speed networks (up to 38.4 kpbs) on RS485.

NetBEUI: A network protocol usually used in small, department-size local-area
networks of 1 to 200 clients.

NetDDE: A version of Dynamic Data Exchange (DDE) that allows communications
between applications running on different PCs over network connections.

NT Service: A designated piece of software which runs in the background of
Windows NT and can be set to automatically start when the machine is booted up.
For example, the PMCS DDE Server can be set to operate as a Windows NT Service,
rather than a manually-launched application. Another advantage of NT Services is
that they are persistent across multiple user logins and logouts; that is, PMCS DDE
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Server when operating as a Windows NT Service will not shut down when a user logs
off.

ODBC: Open Database Connectivity. An inter-application communication protocol
required for certain PMCS client applications to share data. Automatically installed
and configured as part of the PMCS installation routine.

PMCS: Power Management Control System. GE’s high-performance power-
management system for Windows NT, including open network protocols, waveform
capture and analysis, event logging, and several optional modules.

POWER LEADER: The family of GE power-management devices, including meters,
relays, trip units, and software.

RS485: An industry-standard communication network supporting up to 32 networked
devices. RS485 provides medium-speed, reliable communication transport through
shielding, balanced transmission voltages, and termination.

SCADA: Supervisory Control and Data Acquisition. A category of systems that
primarily acquires data for logging and analysis, as well as providing supervisory
control in applications without time-critical requirements. Power-management
systems are a direct application of SCADA technology.

TCP/IP: Transmission Control Protocol / Internet Protocol. An industry-standard
protocol typically used on Ethernet or Token-Ring local-area networks (LANs).

Waveform Capture: A standard PMCS application that provides a window into
power-quality data in an electrical system. Waveform Capture is used to view
snapshots of voltage and current waveforms from various points in an electrical
system to analyze harmonics and unusual system behavior.
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System Requirements
The following table shows the minimum and recommended PC system configuration
for running PMCS Version 6.9. Note that regardless of configuration, the PC system
must be Windows NT-certified according to the Microsoft Windows NT 4.0
Hardware Compatibility List, available from Microsoft (www.microsoft.com). In
addition to the requirements described below, setting up PMCS and EPM 7700
workstations will require Windows NT Administrator-level authority privileges.

Minimum Recommended
Pentium II processor, 300 MHz Pentium III processor, 600 MHz
Microsoft Windows NT 4.0 Workstation,
Service Pack 6, Windows 2000 Professional
Cimplicity version 4.01 Service Pack 9 or
Cimplicity version 5.0 Service Pack 1

Microsoft Windows NT 4.0 Workstation or
Server, Service Pack 6, Windows 2000
Professional, Cimplicity version 4.01 Service
Pack 9 or Cimplicity version 5.0 Service Pack 1

128 megabytes of RAM 256 megabytes of RAM
512K cache 512K cache
4-gigabyte hard disk 10-gigabyte hard disk
CD-ROM drive CD-ROM drive

Note: For systems using MMS technology, refer to Using MMS Servers with PMCS
for minimum system requirements.

Additional hard disk space is recommended for increased storage of log and trend
data. Also recommended are an uninterruptable power supply (UPS), 17” or larger
monitor, tape drive or other backup mechanism, and (if Remote Access technical
support is desired) a 28.8 Kbps or faster modem.

The version of CIMPLICITY installed must be 4.01 or greater, and HMI Service
Pack 9 must be installed. Also, the "Advanced DDE Communications" option must
be installed.

Microsoft Internet Explorer 3.02 or later is required to run the EPM 7700 component
help system. To take advantage of all available .HTML help features, Internet
Explorer version 4.0 or higher must be installed. (The latest version of Internet
Explorer is available at www.microsoft.com.)

Please note that the host PC requirements are directly tied to the complexity of your
PMCS system. The minimum requirements will suffice for a simple PMCS system.
However, as the number and complexity of your power management device grows,
and you add more complex software requirements such as custom interfaces designed
with third-party HMI tools, your PC requirements increase as well. A faster processor
and more memory provide better performance for your PMCS system.

Where to Get Help
The GE Industrial Systems Resolution Center is available at 1-888-GE-RESOLV to
answer your questions about installing or using PMCS. Please have your product
serial number(s) ready when calling.

Also, technical notes are available on the Internet at:
http://www.ge.com/industrialsystems/pmsys/Technote/noteidx.htm
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What’s next?
The following chapters discuss the details of installing and getting quick results from
your new PMCS software. Set aside at least an hour and be sure to follow the
procedures carefully to guarantee correct installation of your PMCS software.
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Installing the Software

Computer Preparation
PMCS must be installed on a PC running Windows NT Workstation 4.0. This host
PC must be dedicated to the PMCS system. Performance and data integrity cannot be
predicted unless the PC is configured solely for the purpose of running PMCS.

The Windows NT System control panel offers a Performance tab that allows you to
boost performance for the foreground application. For PMCS, must be changed to No
Performance Boost for Foreground Application (default is Maximum), as shown
below:

The Virtual Memory setting may be left at the Windows NT defaults.

Make sure your system meets these requirements before proceeding with the
remaining installation steps. PMCS will not run correctly unless these requirements
are satisfied.

Installing CIMPLICITY
If CIMPLICITY HMI was provided with your PMCS software, you must install it
before proceeding. If your computer already has CIMPLICITY HMI installed, make
sure the following requirements are met.
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•  CIMPLICITY HMI for Windows NT (Intel) Version  4.01 with HMI Service
Pack 9 or CIMPLICITY HMI for Windows NT (Intel) Version 5.00 with HMI
Service Pack 1is required. Other versions of CIMPLICITY may not be
compatible with PMCS.

If you are installing CIMPLICITY HMI, follow the directions provided with the
software (inside the CD jewel case). Choose CIMPLICITY HMI as the product to
install, then select either the HMI Server or Viewer as the product option to install,
and C:\CIMPLICITY\HMI as the installation directory. If you install the Server
option, also install Server Option - Communications - Advanced DDE/DDE
Client.

Installing Additional Software
Install any additional software, such as Microsoft Excel, at this point in the
procedure. Follow the instruction procedures provided by the manufacturer.

For instructions on installing SISCO Systems' MMS Server for use with PMCS, refer
to the section titled Using MMS Servers with PMCS.

RS485 PMCS Network Interfaces
If you are using an RS485 interface card to connect to the PMCS network, install the
card following the manufacturer’s installation instructions. Be sure to install any
Windows NT drivers provided by the interface-card vendor. Typically, drivers are
installed at Control Panel>Network>Adapters>Add Adapter by following the
instructions. You may be prompted to insert the manufacturer’s disk into the A:
drive.

From the Network
control panel, select
the Adapters tab,
then click Add.
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Select the appropriate network adapter from the list and click Have Disk…. Follow
the instructions provided on the screen to complete the network card installation.

For PMCS systems using one or more GE Multilin RS232 to RS485 converters (or
equivalent), no additional drivers are required.

Ethernet PMCS Network Interfaces
If you are using an Ethernet interface card to connect to the PMCS network through
one or more Ethernet Gateways or directly to a network of Universal Relays (Modbus
TCP/IP), follow the manufacturer’s installation instructions and be sure to install the
provided Windows NT drivers using Control Panel>Network>Adapters>Add
Adapter. Refer to the screen shots above for an example, though the selections will
differ based on the hardware you are installing.

Ethernet requires the TCP/IP protocol for compatibility with the Ethernet Gateway or
Universal Relays. TCP/IP should have been installed with Windows NT Workstation
4.0; you can check this using Control Panel>Network>Protocols. The screen shot
below shows a system with TCP/IP installed. If TCP/IP is not installed on your
system, refer to the Windows NT documentation for installation instructions.
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Ethernet users:
Check the
Protocols tab of the
Network control panel
for TCP/IP Protocol.

Local Area Network (LAN) Interfaces
PMCS supports multiple Viewer Workstations through links over a local area
network. Thus, in addition to the PMCS network interface, the Host PC may also
have a LAN interface.

A Host PC with an Ethernet PMCS network interface may use either the same
Ethernet card as the LAN interface or a separate LAN interface card. A Host PC with
an RS485 PMCS network interface requires an additional LAN interface card to
support Viewer Workstations.

Typical LAN interface cards include Ethernet and Token Ring. Any LAN interface
card should be installed according to the manufacturer’s instructions.
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Installing Additional Software
Install any additional software, such as Microsoft Excel or COMTRADE file
browsers for analyzing waveform files, at this point in the procedure. Follow the
instruction procedures provided by the manufacturer.

Installing the EPM Software Components
The EPM 7700, EPM 7600 and EPM 7500 Meters require additional software to
operate with PMCS client software such as the Event Logger, Waveform Capture
Module, or CIMPLICITY Wizards. This is because the EPM 7700, EPM 7600 and
EPM 7500 are not compatible with the standard PMCS DDE Server. Instead, a
separate DDE Server called the 7700 Gateway Server must be installed, along with a
pair of ‘helper’ applications, the Communications Server and the ION_Link Server.
The Communications Server processes all communications between the Gateway
Server and/or the ION_Link and the Ethernet-based EPM 7700, EPM 7600 and EPM
7500 meters.

The EPM 7700 software may be selected during the standard PMCS installation
routine. If you are not using any EPM devices in your PMCS setup, you do not need
to install the EPM options during PMCS installation.

The EPM software components do require some special configuration beyond that
required for other PMCS components. Refer to the section titled EPM Device Special
Considerations for details after running the installation routine described in this
section.
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Installing the PMCS software
Once you have set up Windows NT and any third-party software (if appropriate) you
are ready to install the PMCS software. PMCS should be installed last, after all other
software installations are completed. Your PMCS software is provided on a CD-
ROM.

The diagram below depicts the relationship of the Host PC and any optional Viewer
Workstations  in your system. Follow the specific instructions below for software
installation on Host PCs and Viewer Workstations.

................
PMCS

Network(s)

Host
PC

View
Node

View
Node

LAN

View
Node

View
Node

eLicensing PMCS software

General Electric Industrial Systems has added security technology that requires your
PMCS software to be licensed in order to run. A separate license is required for each
computer that will receive PMCS. Each eLicense Order ID that is sent with your
order corresponds to one license.

You license your software as part of the automated PMCS installation process.
When you launch the installation process the first screen that will appear will be your
eLicense Option screen (see below). This screen allows you  to either trial or fully
license  your PMCS software.
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30 Day Trial
You have the option to Trial PMCS for 30 days through the 30-Day Trial
selection on this screen. All functionality of PMCS is available to trial users
and all configurations made for the software will be maintained from one
use to the next. A single trial is registered to each PC and may not be
uninstalled and re-installed for another trial.

Licensing via the Web
Choose the Web License option if you have a working internet connection
on your PMCS computer.  This option will automatically connect you to
General Electric Industrial Systems’ eLicense distribution system.  Once
connected, an automated process will retrieve your unique PMCS eLicense
key.

Selecting the Web License option from the License Option brings you to
the  Web License Screen. This screen requires  you  to enter your  eLicense
Order ID. This information is contained on the  Order Confirmation Sheet
that accompanied your PMCS software or it can be obtained from your
Purchase Confirmation e-mail Enter the Order ID and click on Get License
to initiate the Web connection to General Electric Industrial Systems’
eLicense distribution system.
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Similar to the trial, each eLicense is registered to the computer  In which case, the
eLicense Order ID can only be used for one computer  The software must be
unlicensed to be re-licensed  with the same eLicense Order ID on another computer
Select Launch from your License Installation Success Screen to continue installing
PMCS.

License by Phone
If your PMCS computer does not have an internet connection you may license your
PMCS software over the phone by selecting the By Phone option on the Licensing
Option Page. This will bring you  to a Phone License screen. This screen provides a
Toll-Free Assistance Line 1-888-GE-4-SERV (international callers, please use 540-
378-3888) that can be used to retrieve your unique eLicense key from a General
Electric Industrial Systems customer support representative (please select Technical
Support, then Software Licensing from the phone menu).   You will be asked over the
phone for your  System Identifier, Version ID, and Order ID and in return you will
be  given your  eLicense key. The eLicense Order ID from the License
Confirmation sheet and the eLicense key given over the phone are required to Install
the eLicense.

Similar to the trial, each eLicense is registered to the computer  In which case, the
eLicense Order ID can only be used for one PMCS computer . The software must be
unlicensed to be re-licensed with the same eLicense Order ID on another computer .
Select Launch from your License Installation Success Screen to continue installing
PMCS.

Host PC Installation
Every PMCS system requires one Host PC that is directly connected to the PMCS
network and communicates with the power-management devices. The Host PC is also
typically used to view and analyze data.

If you are installing multiple PMCS catalog numbers on the Host PC, you will need
the CD and serial number from each package. Follow the Installation Steps section
below. If the Host PC will be providing data to View Nodes, be sure to refer to GEH-
6510, Network and Device Configurator, to configure NetDDE for operation with the
View Node PCs.

Viewer Workstation Installation
PMCS supports optional Viewer Workstations, which interact with the power-
management network through NetDDE links to the Host PC. Viewer Workstations
are not directly connected to the PMCS network but are connected via LAN to the
Host PC. Viewer Workstations are not mandatory in a PMCS system because the
data is available for display and analysis at the Host PC. When installing PMCS
View Nodes, be sure to use only an appropriate catalog number for the installation.
Do not install any other PMCS software on a PMCS Viewer Workstation.
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NOTE: The EPM software differs from the standard PMCS usage of Viewer
Workstations. Refer to the section titled EPM Device - Special Considerations for
more details on EPM Workstations and View Nodes.

PMCS Installation Steps
Follow the procedure below to install each PMCS catalog number. Be sure the
catalog numbers you are installing are appropriate for the destination PC (Host PC or
View Node). Close any open applications before installation.

1. Insert the PMCS Installation CD into the CD-ROM drive.

2. Click the Start button from the Windows NT Task Bar and select Run.

 
3. In the Run dialog box, enter X:\setup (where X is the appropriate CD-

ROM drive designation).
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4. The GE PMCS 6.9 Setup screen appears as shown below. Read the general information
and disclaimers shown on the screen, and click Next.

 
 When you select the Next button in the Welcome screen, the PMCS license agreement screen

is shown. Please take a moment to read over the license agreement, then click Next.
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5. At the User Information screen shown below, enter your name, your company name, and
the serial number for the PMCS component you are installing. Serial numbers for PMCS
components are located on the PMCS CD-ROM jewel case. If you make an error in the
serial number, the installation routine will prompt you for a correct PMCS serial number.
When you have completed the registration information, click Next.

 
 When you select the Next button in the User Information screen, a registration confirmation

screen prompts you to verify your entries. Ensure that you have made no mistakes in the
User Information fields, then continue.
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6. At the Choose Destination Location dialog, specify a drive on which to install PMCS.
Default is “C”. Click Next to continue.
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7. At the Setup Type screen, select either a Custom installation, standard PMCS
installation, or PMCS with EPM 7700 Components. PMCS installation is recommended
and will install all components for the PMCS catalog number you entered in the User
Information screen. Select PMCS with EPM 7700 Components if you will be installing
EPM 7700, EPM 7600 or EPM 7500 devices in your network. Select Custom if you wish
to select specific PMCS software components to install. Click Next to continue.

 
 If you select PMCS with EPM 7700 Components, you may also be required to view an

additional license agreement for MS Data Access components. This software is required
by the EPM 7700 software. Take a moment to read the license agreement information,
then continue.
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8. If you did not select “PMCS with EPM 7700 Components” in the Setup Type dialog box
(Step 7), skip this step and proceed to Step 11.

 If you are installing the EPM 7700 Components, select whether this is to be a Primary node
installation or Secondary node installation. You must install at least one Primary node on
your PMCS network; it is recommended that you install the Primary node at the same
machine as the PMCS DDE Server for convenience in configuration. Secondary nodes are
akin to PMCS view nodes and may be installed on remote machines to access EPM 7700
data from the Primary node. (For additional details on Primary and Secondary nodes, see
the section on configuring EPM 7700 components later in this chapter.)
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9. If you did not select “PMCS with EPM 7700 Components” in the Setup Type dialog box
(Step 7) or if you selected “Primary Node Installation” in Step 8, skip this step and
proceed to Step 11.

 If you selected Secondary Node installation in Step 8, the following dialog box appears
prompting you to select either "Full Station" or "Stationless" node installation. If you are
installing software on a computer that will service EPM 7700, EPM 7600 or EPM 7500
IEDs directly, choose "Full Station". If you are installing software on a computer that will
not be connected to IEDs but will be used to access data from other network workstations,
choose "Stationless". For more details on EPM 7700 network configuration, refer to the
EPM Device Special Considerations section later in this manual, or to DEH-40035, the
GE 7700 Gateway User’s Guide.
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10. If you did not select “PMCS with EPM 7700 Components” in the Setup Type dialog box
(Step 7), or if you selected “Primary Node Installation” in Step 8, skip this step and
proceed to Step 11.

 If you selected Secondary Node installation in Step 9, the following dialog box appears
prompting you for the name of the computer on which the Primary Node is installed.
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11. Select the Program Folder for PMCS installation. It is recommended that the default
Program Folder be chosen. Click Next to continue.
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12. If you chose the “PMCS” installation, you may be presented with one or more DDE
Server selections depending upon the PMCS catalog number you entered in the User
Information screen. Select only the DDE communications servers that you will be using
in your system
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13. Next, the installer prompts you to choose how you wish to install the PMCS components.
You may install them as standard applications which may be launched from the Start
menu, or you may choose to install the PMCS components as Window NT Services. NT
Services can be set to start automatically when the machine is powered up, and have the
powerful advantage of running in the background with no regard to users' logon/logoff
cycles. For example, the PMCS Waveform Server, when set to run as an NT Service,
continues to collect waveform data whether or not a user is logged on.  (For further
information on NT Services, refer to your Windows NT documentation.)

 Choose whether to configure your PMCS components as NT Services, then select Next.
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 If you chose to configure NT Services, you'll also need to select the appropriate DDE Server.
The Select DDE Sever Configuration dialog is displayed for this action. Select the DDE
Server(s) you will be using with your application, then choose Next.
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14. The Selected Components screen offers you the opportunity to verify the installation
settings before any files are copied to your hard drive. Confirm that the installation
settings are correct, then click Next. The installation program copies the appropriate files
to your hard drive.

 
 If you have selected the EPM 7700 System Components (either manually when performing a

Custom install or automatically when PMCS with EPM 7700 Components install is
selected), the installer will check your system for a copy of Microsoft Internet Explorer,
version 3.02 or higher. This is because the EPM 7700 software components use .html-
format help files which require Internet Explorer to view. If Internet Explorer is not
found, the following dialog box appears:

 
 If you wish to view the EPM 7700 software help files, you should separately install Microsoft

Internet Explorer, version 3.02 or higher. (To take advantage of all available help system
features, Internet Explorer version 4.0 or higher is required.) Internet Explorer is not
included as part of PMCS. You may obtain the latest version of Internet Explorer by
downloading it from www.microsoft.com.



CIMPLICITY PMCS Read-This-Book-First Installing the Software  ••••   35

15. After completing the selected PMCS installation, the installation program checks the host
PC for an older version of the POWER LEADER Modbus Monitor Proxy software. If the
installer locates the Proxy software, it prompts you to update the Proxy to the PCMS 6.x-
compatible version before finishing the PMCS installation routine. (If your system does
not use POWER LEADER Modbus Monitor devices or does not have the Monitor Proxy
software installed, the PMCS installer will skip this step.)

 
16. At this point, the installation program copies the appropriate files to your hard drive.

17. After the Setup program finishes installing the PMCS components you have selected, you
will be prompted to install the Adobe Acrobat Reader software. If you do not have
Acrobat Reader 3.0 or later installed on your PC, you may wish to install Acrobat Reader
at this time. The PMCS CD-ROM includes a full complement of technical documentation
in Acrobat PDF format which may be viewed with the Acrobat Reader program. The
documentation is located in the TechDocs directory of the CD-ROM.

18. After the installation of Acrobat Reader, you will be prompted to install Waveform
Analyst software. Install Waveform Analyst application to browse a large amount of
power quality survey data with ease, using a graphical interface on a Microsoft Windows
platform
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19. When all the installations are complete, the Setup Complete dialog box, shown below,
prompts you to restart your computer.

 
 After restarting your computer, be sure to view the ReadMe file to check any late-breaking

information useful to the configuration or operation of your PMCS system.

NOTE: Your computer MUST be restarted after installing PMCS software. This step is
critical to proper operation of the software, as it enables the following to happen:

•  The operating system will register the new software components.
•  The MMS Server (if installed) will update its alias table.
•  Initial network configurations for EPM7700, EPM 7600 and EPM 7500 devices will

be created.
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PQ Analyst Installation Steps
Follow the procedure below to install each PMCS catalog number. Be sure the catalog
numbers you are installing are appropriate for the destination PC (Host PC or View Node).
Close any open applications before installation.

Insert the PMCS Installation CD into the CD-ROM drive. If CD AutoStart is enabled, the
PMCS installation routine will launch automatically. In this case, skip steps 2 and 3 and
proceed directly to step 4.

Click the Start button from the Windows NT Task Bar and select Run.

1. In the Run dialog box, enter X:\setup (where X is the appropriate CD-ROM drive
designation).
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2. The GE PMCS 6.9 Setup screen appears as shown below. Read the general information
and disclaimers shown on the screen, and click Next.

 When you select the Next button in the Welcome screen, the PMCS 6.9 license
agreement screen is shown. Please take a moment to read over the license agreement, then
click Next.

3. At the User Information screen shown below, enter your name, your company name, and
the serial number for the PMCS component you are installing. Serial numbers for PMCS
components are located on the PMCS CD-ROM jewel case. If you make an error in the
serial number, the installation routine will prompt you for a correct PMCS serial number.
When you have completed the registration info,click Next.
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4. At the Choose Destination Location dialog, specify a drive on which to install PMCS.
Default  is “C”. Click Next to continue.

5. Now PQ Analyst setup Dialog box appears. Click OK button to continue the PQ Analyst
installation.
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When all the installations are complete, the Setup Complete dialog box, shown below,
prompts you to restart your computer.

NOTE: Your computer must be restarted after installing PMCS software. This step is
critical to proper operation of software.

Un-elicensing PMCS
In order to unlicense your software to use your eLicense Order ID for another computer
– you must have an internet connection. To retrieve your license for use on another
PMCS installation, simply right click on any PMCS executable on your desktop and
select unlicense.

The screen will request the eLicense Order ID to be entered.
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A screen will appear to indicate that you have successfully un-eLicensed and you may
now take the eLicense Order ID for use on another PMCS installation.

* Please note that you can not retrieve an eLicense for re-use through the unlicense
process past 3 years of initial Licensing.

Uninstalling PMCS
All PMCS software is provided with an uninstall utility to fully remove PMCS
components from your system. Uninstalling PMCS will permanently delete any
configuration information.

NOTE: The Uninstaller may not delete some files such as error logs, system logs,
and configuration records, which are created after the PMCS installation is complete.
Since these files are not part of the initial installation, they will not be removed by the
Uninstaller, and must be deleted manually.

If you are uninstalling EPM 7700 components, be aware that the Pegasys System Log
Service does not properly unregister itself as an NT Service. The following
procedure will allow you to manually uninstall this component: the remaining PMCS
software can then be uninstalled in the usual manner.

Uninstalling the Pegasys System Log Service:
1. Open a Command Prompt window.

2. Make the C drive the current directory (assuming your Windows system files
reside on the C drive).

3. Type “slservice –e” EXACTLY as shown and hit enter.

4. If the Pegasys System Log Service was installed and running you will receive the
message “Pegasys System Log Service stopped”. If you do not receive this
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message, the Log Service was not installed on your system. Exit the command
prompt and continue uninstalling PMCS.

5. If you received the correct message in step 4, uninstall the service. Type
“slservice –u” EXACTLY as shown and hit enter. A message appears indicating
“Pegasys System Log Service uninstalled”. Exit the command prompt and
continue uninstalling PMCS.
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Reinstallation Steps
Follow the procedure below to reinstall your PMCS software.

1. If your system includes the PMCS Interface Toolkit, uninstall the CIMPLICITY
Wizards from any third-party HMI tools.

2. Close any open applications.

3. Insert the PMCS Version 6.9 CD into the CD-ROM drive.

4. From Start menu, select Run and enter X:\setup (where X is the appropriate
CD-ROM drive designation).

5. Read the general information and disclaimers shown on the screen and click
Next.

6. Enter your name, your company name, and the serial number located on the
PMCS CD jewel case, then click Next. If you make an error in the serial number,
the installation routine will prompt you for a correct PMCS serial number.

7. Choose the installation type; either PMCS, PMCS with EPM 7700
Components, or Custom installation. PMCS or PMCS with EPM 7700
Components installation will reinstall all components of the appropriate PMCS
catalog number. Select Custom if you wish to reinstall only selected PMCS
software components.
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Upgrading from previous versions to PMCS 6.9
PMCS 6.9 provides an easy-to-use, automatic upgrade path from previous versions of
PMCS. The software installer examines your hard drive and, if it locates any previous
version of PMCS, it makes decisions on upgrading each component.

Follow the procedure below to upgrade your currently installed PMCS version (such
as 5.0, 5.1, or 6.0) to PMCS version 6.9. This procedure assumes you have an
existing PMCS installation with configured ports, topics and (optionally) generic
topics, and that CIMPLICITY Wizards are installed in the generic HMI application.

WARNING: PMCS 5.1 and PMCS 5.1b Modbus DDE Server users only: Upgrading
from PMCS 5.1 to PMCS 6.9 may cause the Modbus version of the DDE Server to
lose its port configuration. You may need to reconfigure your communications ports
from the PMCS DDE Server after upgrading. The Ethernet version of the DDE
Server is not affected.

PMCS 5.0 users: Port configuration is lost when a PMCS 5.0 configuration file is
converted to a PMCS 5.1b configuration file. You will need to reconfigure your
communications ports from the PMCS DDE Server. Refer to GEH-6510 for
instructions. Also, any generic topics you may have configured at the PMCS DDE
Server will be lost, and you will need to re-configure these generic topics.

1. Close any open applications, and insert the PMCS 6.9 CD into the CD-ROM
drive.

2. From Start menu, select Run and enter X:\setup (where X is the appropriate CD-
ROM drive designation).

3. Read the general information and disclaimers shown, then click Next.

4. Enter your name, your company name, and the serial number located on the
PMCS CD jewel case, then click Next. If you make an error in the serial number,
the installation routine prompts you for a correct PMCS serial number.

5. Choose either PMCS, PMCS with EPM 7700 Components or Custom
installation. PMCS or PMCS with EPM 7700 Components installation will
reinstall all components of the appropriate PMCS catalog number. Select
Custom if you wish to reinstall only selected PMCS software components.

6. After upgrading, existing HMI applications that use PMCS wizards will continue
to work. If you upgrade device firmware you will need to replace the old wizard
screens with new screens to maintain compatibility between your application and
the device. The old PMCS wizards will remain on your system unless you
uninstall the previous version of PMCS. It is highly recommended that all new
applications use PMCS 6.9 Advanced wizards exclusively.

7. After upgrading, launch the PMCS DDE Server. The Server will convert your
previous PMCS configuration to a PMCS 6.9 configuration.

WARNING: Event Logger users only: Upgrading your EventServer or Eventlogger
application will result in the loss of all device configurations and annunciator panel
items. Make a list of these items so that they may be reconstructed in the new
application. Existing database files will be backed up by the installation program, but
they cannot be viewed with the PMCS 6.9 EventViewer. To view databases created
with earlier editions of PMCS, use Microsoft Access to open the .mdb files.
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Configuring the Software

To get the most out of your new PMCS system, follow the directions below to
configure your system.

Organize Your Information

Host PC
You need the following information to properly configure the PMCS software for the
Host PC. This information is used throughout the configuration process and you
should archive it for any future maintenance of your system.

For RS485 PMCS network interfaces, you need to list all devices in the power-
management network (including Modbus Concentrators) with associated device
types, Modbus RTU addresses, and COM ports. Assign names of less than 20
characters (no spaces) to these devices.

For example, in a simple system with four devices (and one Modbus Concentrator),
you may have a table similar to the following.

COM port Modbus RTU Address Device Type Device (Topic) Name
1 2 MODCONC MCI
1 12 E3720 Main_Meter
1 33 PLEPM Mfg_Meter
1 61 MVT Mfg_Breaker
2 210 ML269 Mill_Relay

For an Ethernet PMCS network interface (Ethernet Gateway), you must list all
devices in the power-management network, including the device types and Modbus
RTU addresses. You need to know the appropriate Ethernet Gateway IP address and
COM port (1–4) to which each device is connected. Assign names of less than 20
characters (no spaces) to these devices.

For example, in a simple system with 10 devices, you may have a table similar to the
following (this system uses one Ethernet Gateway and three Modbus Concentrators).
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Ethernet Gateway
IP Address

COM
port

Modbus RTU
Address Device Type Device (Topic) Name

10.47.28.201 1 2 MODCONC MC1
10.47.28.201 1 12 E3720 Main_Meter
10.47.28.201 1 33 PLEPM Mfg_Meter
10.47.28.201 1 61 PLEPM Plating_Meter
10.47.28.201 2 12 MODCONC MC2
10.47.28.201 2 66 PLEPM Office1_Meter
10.47.28.201 2 80 PLM Office2_Meter
10.47.28.201 2 90 MDP Feeder1_Relay
10.47.28.201 2 100 MVT Mfg_Breaker
10.47.28.201 3 200 ML269 Mill_Relay
10.47.28.201 4 21 MODCONC MC3
10.47.28.201 4 201 MVT Plating_Breaker
10.47.28.201 4 210 MVT Office_Breaker

View Node
You should configure View Nodes after you have configured and tested the Host PC
to ensure all functions are operating. View Nodes require a copy of the network
architecture list used above. Refer to GEH-6510, Network and Device Configurator,
for complete configuration instructions.
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Configuration Procedure
Follow the procedure below to efficiently configure your system and minimize your
time to startup.

Host PC Configuration
1. Configure the DDE Server. Your Host PC will likely have several versions of

the DDE Server installed (RS485-Modbus, TCP/IP Modbus, TCP/IP
Encapsulated Modbus and Ethernet-TCP/IP). Configure only the server
appropriate for your PMCS network interface (GE32MODB, GE32MTCP,
GE32GTWY or GE32ENET). See GEH-6510, Network and Device
Configurator, for complete details.

2. EPM 7700, EPM 7600 and EPM 7500 users only (all others proceed to step
3): Configure the Communications Server and GE 7700 Gateway Server. If you
installed the EPM software options and you are going to use EPM 7700, EPM
7600 or EPM 7500 devices in your PMCS network, you will need to configure
both the Communications Server and the GE 7700 Gateway Server. For Comm
Server configuration instructions, refer to EPM Software Components
Configuration later in this guide. For GE 7700 Gateway Server configuration
instructions, refer to DEH-40035, the GE 7700 Gateway Server User’s Guide.

3. Configure the user interface. If your system was provided with a generic HMI
software application, either load or create the custom HMI (using the Interface
Toolkit wizards, if appropriate; see DEH-210, CIMPLICITY PMCS Interface
Toolkit or refer to the HMI software’s documentation.

4. Configure the applications. As appropriate, configure the following application
modules, referring to the instruction manuals provided.

•  Event Logger, GEH-6512
•  Waveform Capture, GEH-6511

5. Test the applications. Test the functioning of all applications to ensure proper
Host PC operation. Do not proceed to step 5 until you are sure the Host PC
operates as expected.

6. Set up NetDDE. If your system has one or more View Nodes, set up NetDDE
shares and trusts in the Host PC, following the procedures in GEH-6510,
Network & Device Configurator and the CIMPLICITY HMI documentation.

7. Set up NetDDE. If your system uses the PMCS Waveform Capture client, and
you intend to access waveform data from View Nodes, set up NetDDE shares
and trusts for the PMCS Waveform Server following the procedures in GEH-
6511, PMCS Waveform Capture Module.

Viewer Workstation Configuration
1. Configure the user interface. Load the custom MMI. Refer to the CIMPLICITY

HMI documentation as appropriate.

2. Configure the applications. As appropriate, configure the application modules,
referring to the instruction manuals provided. See step 3 of the Host PC
Configuration for the appropriate instruction manual numbers.
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EPM Software Components Configuration
The EPM 7700, EPM 7600 and EPM 7500 requires several separate software
components which are installed during the PMCS setup. This section provides a brief
overview of the steps required to configure these components; the following section
describes the EPM software components in greater detail.

For details of using the NetBuilder software, refer to the Configuring the EPM 7700
Device Network section of this manual, and to DEH-440035, the GE 7700 Gateway
User’s Guide.

1. Launch the NetBuilder application. From the Start menu, select
Programs>Power Management Ltd>Utilities>Network Builder.

2. Insert a workstation(s). Normally all the workstations in a PMCS network are
automatically configured during the installation of the software – these
instructions are provided in case you need to enter the information manually.
Select the Items menu from NetBuilder, and choose Workstation to insert a
workstation. Name the workstation (up to 15 alphanumeric characters, the first
character must be alphabetic), and choose OK. Repeat this step for each
workstation (computer) in your network.

3. Insert Ethernet Sites. Select Items>Insert>Ethernet Site to insert an Ethernet site.
Set the proper time synchronization options, then choose OK. Repeat this step to
add additional sites to the workstation if necessary.

4. Insert devices to the site. Select Items>Insert>Device, and complete the dialog
box with the proper device type, Group, Ethernet address and name for an
Ethernet device (EPM 7700, EPM 7600 or EPM 7500). The device name may
be no more than eight alphanumeric characters, and the first character must be
alphabetic. The IP service port field must be "7700" for any device connected to
the Ethernet, and "7800" for any additional device connected through an EPM
7700’s RS485 port. Choose OK to close the Insert Device dialog box. Repeat
this step as necessary to add additional devices to the site.

5. Save and exit. When all workstations, sites, and devices have been added, select
the save icon and then exit.
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EPM Device-
Special Considerations

Introduction
The GE EPM 7700, EPM 7600 and EPM 7500 devices add new level of power
management capabilities to PMCS. These EPM devices also require some special
configuration which is not necessary for other PMCS-compatible devices. This
section describes the additional requirements and configuration steps necessary to use
the EPM 7700, EPM 7600 and EPM 7500 in conjunction with PMCS.

NOTE: If you are not using the EPM 7700, EPM 7600 or EPM 7500 meters in your
PMCS network, it is not necessary to read this section of the manual.

Although the EPM 7700, EPM 7600 and EPM 7500 meters are compatible with
PMCS and its client applications (Waveform Capture, custom wizards, etc.), and
EPM 7700, EPM 7600 and EPM 7500 meters may co-exist on the same Ethernet as
other PMCS network segments, the EPM 7700, EPM 7600 and EPM 7500 use a
slightly different metaphor than a straight PMCS network. An EPM device power-
monitoring network is comprised of a number of nodes that are connected to the
PMCS workstation through Ethernet links.  Nodes in the power-monitoring network
are IEDs such as the EPM 7700 meter (power meters are also referred to ‘meters’ or
‘devices’).  IEDs may be distributed across one or more networks as required to
service the particular application.
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EPM Software Components
There are four major components of the EPM software. The Network Builder, ION
Designer, Communications Server, and ION_LINK DDE Server each interact to
support the EPM 7700, EPM 7600 and EPM 7500 Meters. When you selected the
“PMCS with EPM 7700 Components” selection during the PMCS installation
routine, these software components were installed automatically. The four
components and their functions are described below.

Network Builder: Building the Network
Configuration File
The Network Builder presents a graphical view of the EPM 7700, EPM 7600 and
EPM 7500 devices in your network, allowing you to easily add, remove or configure
sites, services and meters.  Network Builder creates a central network configuration
file that holds information for the workstation, the network connections, and every
connected device.  You may want to restrict access to Network Builder or the
network configuration file, since if the file is tampered with, EPM 7700, EPM 7600
and EPM 7500 components may be rendered inoperable.

ION Designer: Programming Devices and Software
Nodes
The ION Designer component allows you to customize the operation of an ION-
compliant node, such as 7000-series meters and 3000-series meters.  Be aware that
misuse of ION Designer can adversely affect the operation of your meters.

IMPORTANT: For purposes of PMCS network compatibility, it is CRITICAL that
any EPM 7700, EPM 7600 and EPM 7500 meters be configured with the GE PMCS
standard configuration. Using ION Designer to customize EPM 7700, EPM 7600 or
EPM 7500 functionality can compromise compatibility with the PMCS client
applications attempting to access the device.

Communications Server: System Communications
The Communications Server is the core communications component for EPM 7700,
EPM 7600 and EPM 7500 meters. The Communications Server manages all
communications between the meters connected to your network and the GE77GTWY
and ION_Link DDE Server software applications.

ION_LINK DDE Server: Communication with
Windows Applications
The ION_LINK DDE Server uses Dynamic Data Exchange to share information
with applications such as Microsoft Excel or the CIMPLICITY Wizards.
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Workstation Configuration Guidelines
If you are using the EPM 7700, EPM 7600 or EPM 7500 Meters in your PMCS
network, the following guidelines in this section must be adhered to before
continuing with the EPM configuration.

NOTE: If you are adding a PMCS installation to an existing network, please refer
your network administrator to GEH-6502, the PMCS Network Architecture Guide,
for integration details.

•  Each computer in the network must be assigned a Windows NT
computer name. The name must be one to fifteen alphanumeric
characters in length. Spaces may not be used, and the first character of
the computer name may not be numeric.

•  The System Control Panel should have the Performance Boost for
Foreground Application value set to None, and a paging file should be
created on the C: drive with the Initial and Maximum sizes set to twice
the workstation’s installed RAM.

•  The Network Control Panel’s Adapter tab should have the MS
Loopback adapter installed if a physical network adapter is not installed
in the workstation. Under the Protocols tab, TCP/IP or NetBEUI should
be installed; if TCP/IP is installed, use IP address 192.168.100.xxx and
subnet mask 255.255.255.0 unless your network administrator has
assigned you an IP address. Under the Services tab, install Remote
Access Server (RAS) and configure it by enabling NetBEUI (if using
NetBEUI or, if TCP/IP is used, assign two or more IP addresses,
starting at xxx.xxx.xxx.254 and working down. Set RAS to start
automatically and set access to “entire network” (if available).
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Configuring the EPM Device Network
The PMCS installation routine described earlier in this manual creates initial
workstation and software node entries in the EPM 7700 network configuration file.
After EPM 7700 software components are installed, the next step is to add Ethernet
sites and devices to the PMCS power-monitoring network using Network Builder
software.

Running Network Builder
Network Builder software presents your EPM power-monitoring network graphically,
showing the installed components in a hierarchical tree.  Network Builder allows you
to edit the Network Configuration file— the file that identifies every node in the
EPM power-monitoring network.

The first step is to run Network Builder from the Start Menu:  (Programs > Power
Measurement Ltd > Utilities > Network Builder.)

The following figure shows how Network Builder displays a system comprised of the
basic EPM software components, a single EPM 7700 meter, a Primary Node and a
Stationless Secondary node (also called a ‘view node’).

Workstation: the network name of the
Primary Node computer running the
Communications Server and GE 7700.

Software nodes: Stationless Secondary
nodes appear here.

Ethernet Site: Defines the Ethernet
connection between the PMCS system
and the connected device(s).

Device: Name(s) of attached device(s).



CIMPLICITY PMCS Read-This-Book-First EPM Device- Special Considerations  ••••   53

Building the Power-Monitoring Network in
NetBuilder
When Network Builder is running, you can begin configuring your EPM system by
adding a site to the workstation, then adding devices to the site.  For larger systems
multiple sites are added; one for each network of devices monitored.

NOTE: The PMCS installation wizard creates initial entries for the workstation and
software nodes. If you do not need to make changes to the information provided
during installation, skip this section and begin with the section title "Adding an
Ethernet Site".

Adding a Workstation
When you use the PMCS installation wizard to install a Primary node or Full Station
Secondary node, it creates a Workstation in the Network Configuration for you.
Stationless Secondary nodes do not appear in the network configuration as
workstations, but as software nodes under the Primary workstation. See the section
on software nodes for more information.

To add a new workstation, right click “System” and choose “Insert Workstation”
from the pop-up menu. The  “System – Add Workstation” dialog box appears as
shown below. Type the network name of the computer in the “Name” field. (Use the
default settings on the “Advanced” tab.) Click “OK, then proceed to “Adding
Software Nodes” below.
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Adding Software Nodes
Software nodes identify the various software components in the network. Stationless
Secondary nodes, although they are physically separate computers, do not run a
Communications Server and are therefore not considered Workstations by Network
Builder. Instead, Stationless Secondary nodes appear in the network diagram as
software nodes under the Primary Workstation. Full Station Secondary nodes appear
as Workstations because they do run an instance of the Communications Server.

Acknowledging the Add Workstation dialog brings up a message box asking if you
want to set up the default software nodes – choose Yes to display the software nodes
dialog (shown below). Select only ION Designer and Pegasys ION_Link DDE Server
as shown, then click OK to proceed. The other options are not supported in PMCS
6.9.
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Adding an Ethernet Site
An Ethernet site defines the network connection between the devices and the
Workstation(s). You add Ethernet sites to Workstations, then add devices to the sites.
To add a new Ethernet site, right-click a Workstation name and choose “Insert:
Ethernet site” from the pop-up menu – attach it to the current Workstation. Click OK
to continue.

An Add Ethernet Site dialog box (shown below) appears.

Set the following communications parameters for the site.

•  Enter the Transmit delay setting (in milliseconds). This setting determines
the level of traffic on the network. If the PMCS system is the sole user of the
network, set this value to 5 (or less) to maximize performance. Increase the
transmit delay in situations where the network is shared with other users,
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such as on a corporate LAN. Refer to the PMCS Network Architecture
Guide for guidelines on setting this parameter for best system performance.

•  Change the RX timeout delay from 10000 to 30000 on the Advanced tab.
(See the following figure for Advanced tab.)

All other parameters may be left at their default values for most applications. When
you click OK in the Add Site dialog box, Network Builder will inform you if there is
additional information you must enter.
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Adding Devices (Meters)
To add a meter, right-click on the Ethernet site you want to add the meter to, and
select Insert Device… from the pop-up menu. The Add Ethernet Device dialog box
appears (shown below).

Enter the following information:

•  Choose the meter type from the Type list (Power Measurement 7700 ION).

•  Type a name in the Group box, or choose a Group from the list (by default
the Group will be the name of the workstation).

•  Enter a name for the meter (or accept the default).  The meter name must
begin with a letter.

•  Enter the IP address for the meter.

•  Enter the IP Service Port number (socket) for the meter.  For a 7700, 7600
and 7500 ION this number is 7700, for a 3720 ACM, 3721.

Saving and Exiting
Once you have added all of your sites and devices to the network tree, click the Save
button (or choose Save from the File menu), and exit Network Builder. You have
now configured your EPM 7700, EPM 7600 and EPM 7500 meters to operate with
the PMCS, and you should be able to access EPM 7700, EPM 7600 and EPM 7700
metering data from PMCS client applications.
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Using MMS Servers with PMCS

What is an MMS Server?
PMCS is an extremely flexible system which supports generic DDE Servers. One such server
is the SISCO AX-S4 MMS Server (MMS stands for Manfacturing Message Specification).
AX-S4 MMS ("Access for MMS") is an easy to use tool that provides real-time data
integration for Windows applications. PMCS applications can access data from MMS servers
as well as the PMCS DDE Server. The MMS Server should only be used with PMCS when
integrating devices that comply to the UCA/MMS 2.0 standard.    

For details on the SISCO AX-S4 MMS Server, refer to the AX-S4 MMS for Windows 95 and
Windows NT User's Guide, which shipped with your MMS software product.

For convenience, installation and setup instructions to prepare an MMS Server for access by
PMCS applications are provided here.

System Requirements
The following table shows the minimum recommended PC system configuration for running
the MMS Server and software with PMCS Version 6.9. Note that regardless of configuration,
the PC system must be Windows NT-certified according to the Microsoft Windows NT 4.0
Hardware Compatibility List, available from Microsoft (www.microsoft.com). In addition to
the requirements described below, setting up PMCS and EPM7700 workstations will require
Windows NT Administrator-level authority privileges, as described earlier in the Getting
Started section.

Minimum PC Requirements for using MMS Technology with PMCS
Dual Pentium III processor, 500 MHz or better
Microsoft Windows NT 4.0 Workstation, Service Pack 3 (SP5 recommended),
Windows 2000 Professional, Cimplicity version 4.01 Service Pack 9 or
Cimplicity version 5.0 Service Pack 1
256 megabytes of RAM
512K cache
10-gigabyte hard disk
Super VGA video adapter and monitor
CD-ROM drive
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Installation for Windows NT 4.0
The following installation procedures assume that you are familiar with Windows NT 4.0 and
your computer.

Carefully read the following notes that pertain to installing your AXS-MMS-132-095 product.

Follow the steps below to install AX-S4 MMS for Windows NT on your system.

1. Insert the AXS4-MMS-132-095 CD-ROM into the CD-ROM drive.

2. If the Autorun feature is enabled on your computer, go to Step 3.
Otherwise, click on Start, select Run and enter X:\disk1\setup (where X is the
appropriate CD-ROM drive designation).

3. When the AX-S4 MMS Setup initializes, you are presented with three installation
choices: Typical, Minimal, and Custom. Typical (the recommended selection) will install
the core AX-S4 MMS and SISCO OSI Stack components including AX-S4 MMS
samples. Minimal will only install the AX-S4 MMS and SISCO OSI Stack components.
Custom will allow you to select only those components that are required for your
installation. When using this option, you may also choose to install the electronic copy of
the AX-S4 MMS User's Guide.

4. Follow the instructions on the screen to complete the AX-S4 MMS installation.

 Note: When the AX-S4 MMS Setup is complete you will be asked if you want to restart the
computer. Select the option "No, I will restart my computer later." Click the Finish
button.

5. Install the OSI LLC Protocol Driver for Windows NT.

 Note: If you are replacing an existing version of the OSI LLC Protocol Driver, you need to
remove the current version. Select the Services dialog tab, highlight the OSI LLC
Protocol Driver and click the Remove button. Click on OK. Click the Close button and
reboot your computer. When the system reboots, set the directory to the Windows System
Drivers (System32\Drivers) and delete the file osillc.sys. The installation process will fail
to load the correct OSILLC device driver if an older version of the device driver is
present in the system directory.

6. Click on Start > Settings > Control Panels. From the Control Panel folder, select the
Network shortcut.

7. Select the Protocols dialog tab and click the Add… button.

8. From the Select Network Protocol dialog box, click the Have Disk… button.

9. From the Insert Disk dialog box, type the path {d}:\osillc\winnt, where {d} designates
the letter of your CD-ROM drive, and click on OK to accept the path.

10. From the Select OEM Option dialog box, click on OK, then click the Close button and
restart your computer.

11. The following directory structure should now appear on your computer.

 <Drive>:\OSILL2 All OSI Stack files

 <Drive>:\AXS4MMS All AX-S4 MMS files

 Note: If you are installing for both Windows 95 and Windows NT, you should install the
product into the same directory. This will allow you to share the same configuration
database between both platforms.
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Preparing the MMS Server for use with PMCS
The following instructions describe how to set up your MMS Server for DDE access by
PMCS applications such as Event Logger and Waveform Capture. Both MMS Server and
PMCS must be properly installed before following these instructions.

1. Launch the AX-S4 MMS Configuration Program (Start > Programs > Sisco > AXS4
MMS > AXS4 MMS Configuration), and select Configure > Configuration > Network >
Addressing. This displays the Network Addressing window, shown below.

 
 Choose New to start the wizard for creating a new host. The Host Name Wizard - Host Name

dialog box is displayed.
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2. Enter a name for the host you are creating, then choose Next to display the Host Name

Wizard - Addressing dialog box:

 
3. Complete the TCP/IP Network question by selecting the Yes checkbox and entering an IP

address for the new host, then select Next.
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4. From the Host Name Wizard - Finished dialog box, select Add AR Names to display the

AR Name Wizard - Host Name dialog box, below.

 
5. Enter the Host Name of the AR Name being created, then choose Next.

6. You may skip dialog boxes referring to Seletors by using the Next button until the AR
Name Wizard - AR Name dialog box appears:
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7. Complete the AR Name configuration by entering an AR Name, entering a Comment

(optional) and selecting TCP/IP Transport. Choose Next to complete the configuration.

8. When the Finished dialog box appears, select Finished, then Finished again to complete
and close the wizard.
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